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The Panel’s Key Functions

Function Description

Secondary Power Switch The secondary power switch is located on the lower
left-hand side of the panel below to the power cord.
Pressthe-buttoninthecentreof the panel to turn it

Power Button

The power indicator light on the front left-hand side

is Blue if the panel is turned on and Red if the panel
is off— —_—

Two pens are supplied with the panel and can be

Stylus Pens used simultaneously.

There are 2 USB-A ports on the front bottom right-

USB Ports hand corner of the PX panel, 3 on the lower right-
hand side and 1 on the top.

A USB-C port is located on the front bottom right-

hand corner and on the bottom right-hand side of
the panel.

Connect an external PC or Mac using HDMI, VGA,

Input Connections DisplayPort or USB-C on the bottom right-hand
side.

To obtain touch on the panel, connect the USB-B

cable to the Panel’s Touch Out port and the USB-A
to the PC.

Use Touch out 1 with HDMI in 1.
Use Touch out 2 with HDMI in 2, DP or VGA.

Remote Sensor The remote sensor is on the bottom left-hand side
of the screen.
There are two remote controls for this panel.

The colour buttons in the centre of the remote can
be used to:

Red: Blacks the screen

Blue: Locks the panel. Enter the password (default
0000) to unlock the panel.

IG3 Education Training Manual: EduTouch PX Panel 2.0 4
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Ensure the remote is pointed directly at the sensor located on the bottom left of the

panel.

Switch the LED power on or off ——

Retumn to OPS PC daskiop —— SeeSUELY gl

(-8 number buttons ——

Freeze the content displayed on the screen =

Display or exit input source menu ——
Switch o ViGEA mode ——

Display or exit the sefting menu screen ——

Display desktop (Home page) on the screen ——
Display or exit the current program information ——

&P Y

Page upddewn in OFS PC mode ——

IG3 Education
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Mute the sound

Control buttons for OPS PC

Tekes 5 screenshot and stores the image
onfo an inserted SE. i there is no insened
USE, the screenshot will be stored on the
panel's built-in storage.

Switch to HOMI rode

Return to previous menw or exit the on-screen
mhEn

To confirm or enter & sub-menu or toggks
betwesn oplions durimg menu op=sration.

U=e Arrow buttons to navigate in on-screen
ey

Display OFS onthe screen
Hoife: If no OF3, this button has no funciion.

Wiolume up'down

Set up the slesp timer

Control buttons for OPS PC
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Remote Control Mini

Ensure the remote is pointed directly at the sensor located on the bottom left of the

panel.

Switch the LED power on or off

Display desktop (Home page) on the screen

Display or exit Settings

Freeze the screen

Volume up/down

EduTouch
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Display or exit the source menu

To confirm or enter a sub-menu or toggle
between options during menu operation.
Use Arrow buttons to navigate in an on-
screen menu.

Return to the previous menu or exit the on-
screen menu.

Turns the screen display on or off

Mute the sound

Takes a screenshot and stores the image
onto an inserted USB. If there is no
inserted USB, the screenshot will be
stored on the panel’s built-in storage.
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Home Screen

The Home Screen displays when the panel is turned on and features four icons:
File (File Explorer), Whiteboard, Browser and APPS.

The current date and time are displayed in the centre of the panel.

The File, Whiteboard and Browser icons can be changed by long pressing the icon to
display the available options. Choose the replacement App by tapping it.

Access to additional Apps and tools is available by swiping:

« Right to access the APPS menu.
« Left to access the EShare (Wireless Projection) screen.
« Up from the bottom left-hand or right-hand sides to access the pop-up Tools

menu.
« Up from the bottom centre of the panel to access the Source tool if an optional

OPS is installed.

EduTouch

Screen Sidebars

Identical screen Sidebars are in the middle of both the left-hand and right-hand sides of
the panel. Tap either arrow to display the Sidebar functions.

EduTouch
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Sidebar Functions

Four options can be accessed via the Sidebars:

Displays the Panel’s Home Screen.
Return ‘BACK’ to the previous screen.

View Running Apps.
(Swipe them either way or tap the brush in the lower bottom to remove.)
Annotation Tools (refer to page 8 for additional information.)

Annotation Tools

The Annotation tool is used to write and erase text and objects. Images can be inserted
into the Whiteboard, saved on the local panel or a USB, or shared directly to a device via
a QR code.

Alter the pen’s colour and thickness.

Tap once to erase with your hand. Tap again to slide to clear all.

Save the image as a PNG directly on the panel or an inserted USB,
insert the image into the Whiteboard or share it to a device via a QR code.

Returns to the previous sidebar.

Exit the Annotation Tools.

Note: — If a USB drive is inserted, the image saves automatically to the USB.
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File (File Explorer)

File Explorer is a file management application used to access DOCX, PPTX, XLSX, PDF,
audio and video files stored on the panel (Local Storage), Dropbox, Google Drive,
OneDrive (Network Storage) or a USB (Removable Storage).

To open File Explorer, tap the File icon on the Home Screen or the APPS Screen. The
default folders are displayed and cannot be removed. Additional folders can be added by
touching the + on the top toolbar.

Lol Storage

Bt L

::mmuum = oo @' =] =) 1k =
-

S soops
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|

| B
|
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The following functions are available in File Explorer:

Tool Description
Search Files * Tap the Search Bar on the top centre of the screen.
« Enter the filename from the pop-up keyboard.
- Tap the magnifying glass to start the search.
Add a Folder « Tap on the left-hand side of the top toolbar.
« Enter the folder’s name using the pop-up keyboard.

« Tap OK.

Toggle the views - Tap to toggle between the list view and the grid
view.

oo
oo

Top Menu « Select the type of files(s) to display:
« Allfolders
e Documents
 Notes (Whiteboard files)
* Pictures
» Media files.

IG3 Education Training Manual: EduTouch PX Panel 2.0 9
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Sort Files or  Tap [#] tosortfiles by:
Folders « Name
* Type
» Size
- Last Modified
And display them in Descending or Ascending order.
Select Files * Tap =

+ Select the file(s) by tapping the file, files, or folders, or by
tapping the selection boxes on the right-hand side.
Tap the icon again to select all.

Download Files

» Downloads a file from Network Storage (Cloud) to Local
Storage (Panel).

e Log into your Dropbox, GoogleDrive or OneDrive account.

» Select the file to Download.

« Tap Downloads on the bottom toolbar.

* Choose the download location.

Upload

- Uploads the selected file/folder to Dropbox, GoogleDrive, or
OnebDrive.

Open a File or

T::\p once toselectit

Double Tap to open it.

Folder .
Note: Network Storage files must be downloaded before
opening.
Cut/Copy and * Select the file(s) or folder(s).
Paste * Tapthe Cuticon to cut, or

* Tap the Copy icon to copy.
» Select the location folder: Local Storage (Panel) or
* Removable Storage (USB).

Tap the Paste icon to paste.

Note: Files are added to Network storage by uploading.

Rename a File

« Select the file(s) or folder(s) to rename.

» Tap the Rename icon.
« Enter the new name from the pop-up keyboard.
e Tap OK.

Delete a File « Select the file(s) or folder(s) to delete.
* Tap the Delete icon.
« Tap OK.
Saving Files - File Explorer will automatically save files to an inserted

USB, otherwise files are saved on the panel.

IG3 Education
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Whiteboard

Whiteboard is an interactive whiteboard application which allows teachers and students
to annotate, draw and utilise the various built-in tools.

To access the Whiteboard, tap the Whiteboard icon located on the Home Screen or the
APPS Screen.

Function Description
1. Exit To exit the Whiteboard, tap the Exit icon.
2. Menu To access the Main Menu, tap the Menu icon on the bottom left-hand

corner of the screen.
The options are:
2.1- Pen Recoghnition selects the preferred pen style.
« Traditional — Pen and Finger write in the same style.
» Dual - Pen and Finger write in different styles.
« Combi — The pen writes and your finger either selects or

erases.

2.2 - New File starts a new Whiteboard file.
2.3 - Open opens an existing Whiteboard file.
2.4 - Import uploads a JPEG, PDF, SVG or IWB file from the panel or

USB.
2.5 - Save saves the current Whiteboard file on the panel or USB.
2.6 - Save As saves a JPEG, PDF, UBC, SVG or IWB file to the

panel or USB.

IG3 Education Training Manual: EduTouch PX Panel 2.0 11
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3. Share To share the Whiteboard file:

« Select whether to share to the Cloud (Dropbox, OneDrive or
Google Drive) or via a QR code.

» To use the QR code, the panel and the device must be on the
same network.

- If the QR code is selected, the image is automatically available
on the device.

4. Pen To use the writing tool, tap the Pen icon using one end of the pen.
« Tap again to open the menu.

| - ® 0
BE ® e
i r
’ i3]
2 ® 00

- Using the same end of the pen, tap the pen type, colour and
thickness.

There are five pens:

* Pen
* Paint brush
* Chisel pen

» Text recognition - any written text will be converted into a font.
» Shape recognition — a hand-drawn shape will be converted into a
geometric shape.

The pens can be flipped to write on either end.

5. Eraser To access the eraser, tap the Eraser icon.
* Tap again to open the menu.

Three options are available:

* Slidetoclearall.

* Object eraser — Draw a line through the object or drawing to
erase it.
Point eraser — Select the eraser size and use the hand to erase.

6. Shapes To draw 2D, 3D shapes, or lines, tap the Shapes icon.
« Tap again to open the menu.
Check this image

IG3 Education Training Manual: EduTouch PX Panel 2.0 12
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El » oo Border
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« Select the shape, shape border, fill colours, line type and colour.

- Place the pen in the starting location and drag the shape to the
desired size.

7. Selection To select an object, tap the Selection icon.

 Objects can be selected by: ) ]
0 Using a pen or a finger to draw a circle around an object.
o0 Tappingthe object.

« Once selected, the object can be:

o Moved by holding and dragging it to the desired location.

o Resized by dragging the object’s corner dots to the desired
size.

o Rotated by tapping and holding the icon on the top right.

o Copied by tapping the copy icon on the Selection toolbar. A
new icon appears to the right of the Undo & Redo icons on the
bottom toolbar. Tap it to duplicate the object.

o Cut by tapping the cut icon on the Selection toolbar. A new
icon appears to the right of the Undo & Redo icons on the
bottom toolbar. Tap it to paste the object.

o Deleted by selecting the trash can.

IG3 Education Training Manual: EduTouch PX Panel 2.0 13
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The item’s colour can be changed by tapping the paiciic anu
selecting the new border and fill colours.
8. Rulers To use the geometric measuring tools, tap the Rulers icon. A variety
of measuring tools are displayed: a ruler, set squares, a protractor,
and a QomPass. , . .
« Slide the indicator to show the length in centimetres.
a
em i & b R A
Baider \‘\ “\ Show the length
9. Zoom To access roaming, tap the Zoom icon. The contents of the page can
be:
» resized (expanded to obtain clarity or reduced to obtain more
room).
« moved.
10. Tools To access additional tools, tap the Tools icon to display a toolbar
containing:
a4
Bachkgraund Split canvas Screenahot
@ -2 ™=
Blagnifeer Ielind rmagp Shest
|
Camera
* Background changes the background colour, choose a preset
templated background, or upload an image to be used as a
background.
* Split Canvas — to enable two people to work on the panel at the
same time.
Screenshot — takes a screenshot of a section or the entire
screen.
« Magnifier — enlarges objects.
« Mind map - inserts a mindmap on the screen.
- Sheet —to create a table inside the Whiteboard.
- Camera — to take pictures using an optionally connected camera.
11. Undo To Undo the last action.
12. Redo To Redo the last action.

IG3 Education
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13. Previous To display the Previous page.

14 Page-tist To-displtay-atistof-allpages; tap-the page numbers. A menu
displaying the pages appears on the right-hand side. Tap the page to
open that page, X to permanently delete the page, + to add another
page or the copy icon to copy the page.

To display the Next page.

15. Next
To Add a new page.

16. Add

IG3 Education
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Browser

The browser allows access to basic internet sites. The browser can be accessed from
the Home Screen or the APPS Screen.

To search for a website or for information:
 Tap the Search Bar on the bottom of the screen.
» Enter the search criteria or the website details on the pop-up keyboard.
* Tap Enter.

Discover our Award-Winning

The browser can be customised by:
« Tapping the three dots on the bottom right-hand corner.
» Selecting Settings.
- Selecting Customize.

IG3 Education Training Manual: EduTouch PX Panel 2.0
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APPS

To access additional applications on the APPS screen, tap the APPS i
Screen or swipe the Home Screen to the right.
The APPS Screen is displayed:

con on the Home

EduTouch

The following applications are available:

Application Description
App Manager
<
m m:uﬂ- Uﬂ;nde 'lhu:lall
. Visualizer App Mansger
n Calculator Recarder
Media Center n Updiater
B Eahare m Calondsr
D File While Boged
IG3 Education Training Manual: EduTouch PX Panel 2.0 17
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Calculator

Opens a calculator in a basic view. Tap fx on the top left-
hand side of the calculator to display the functions.

W

tan

sinh cosh tanh

Tap to access conversion shortcuts such as Length,
Area, Volume, Temperature, Speed, Time, Weight and Base
Units.

Calendar

Opens a calendar which can be viewed in a day, a week or a

month view.
Refer to File Explorer on page 9 of the manual for more

File Explorer

Information.

Refer to Browser on page 16 of the manual for more

Browser

informatiorn.
Refer to Appendix B - Media Center on page 53 of the
manual for more information

Media Center

Miracast

Allows Intel devices running Windows to directly connect to
the panel using Miracast.

Note: Tap is not supported with Miracast devices.

Recorder

Settings

IG3 Education

PH: (08) 9228 1681

E: INFO@3MONKEYSAV.COM

Training Manual: EduTouch PX Panel 2.0

18

W: WWW.3MONKEYSAV.COM.AU




e

& - =

MONKEYS
audiovisual

Professional Boardroom Solutions

Settings
NETWARK & CONMECTED
DEVICES
B Ethemet
@ wer
@ Portabie hotesot
B Blusos®
JEVICE
B Pature

B Sound

B Seccny

B Manage apps

B Powe

The following settings are available to configure:

Network & Connected Devices:
« Connect to the schools’ network via Wi-Fi or Ethernet.
» Connect to the panel via the built-in Hotspot.
- Attach a personal keyboard or mouse via Bluetooth.

Device:
- Manage the panel’s picture and sound devices.

System:
* Lock the panel and the panel’s features.
» Enter the password to unlock. (Default 0000)
- Manage apps.
- Manage the Sleep times.

Others:
- Change date and time if required.
- Select the menu language.
» Set the Keyboard and inputs.
« Change the Wallpaper.

Visualizer Use a camera to capture items such as books and display

them. .
Note: An optional camera must be connected.

: Refer to the Whiteboard on page 11 of the manual for more
Whiteboard information.

WPS Office WPS Office accesses DOC, DOCX, PPT, PPTX, XLS, XLSX,

PDF or TXT files stored on the panel or a USB. Files can be
annotated, edited, and saved.

Files can be accessed from the built-in storage, the cloud or a
USB.

IG3 Education Training Manual: EduTouch PX Panel 2.0 19
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EShare

EShare is a wireless display solution preloaded on the interactive panels. It provides
wireless display and touch control for Windows and Mac laptops and desktops, and
wireless display for iPads, tablets, and mobile phones.

Up to nine devices can be displayed simultaneously and up to 50 devices can be

connected.
EShare requires network access, and all devices must be connected to the same subnet

or able to access the Panel’s Hotspot (refer to page 20 for information).
There are three main features available with EShare:

1. Screen Sharing - Up to nine devices (PC/Mac/Mobiles/Tablets) can be mirrored
on an interactive panel at one time.

2. TV Mirror to view the panel’s contents on a device.

3. Remote to control the panel from a mobile device.

Refer to Appendix A on page 27 for more information on EShare.

Hotspotting the Panel

To configure the Panel’s Hotspot:
1. From the Home screen, swipe to the left to display the EShare Wireless Projection
screen.
2. Slide the Hotspot indicator to On.
3. The Hotspot name and password are displayed.
4. Choose the Bandwidth: 2.4GHz or 5GHz.

To hotspot to the panel:
1. Swipe up from either the bottom left-hand or bottom right-hand side of the Home
Screen to display the Tools menu.
2. Tap the Hotspot icon in the top middle of the Tools menu to open it.
3. Connect to the Hotspot.

IG3 Education Training Manual: EduTouch PX Panel 2.0 20
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Tools

To access the Tools pop-up menu, swipe up from either the bottom left-hand or the
bottom right-hand side of the Home Screen.
Quick links to the Wi-Fi, HotSpot and Settings

(refer to Settings on page 18 for more
information) are available from the Tools menu.

EduTouch

S a0

21/12/2022 Wednesday

The following Tools are available:

Tool Description
Calendar Opens a calendar which can be viewed as a day, a week or a month.
TFimer

Timer is both a Countdown Timer and a Stopwatch.

® Stopwatch Tirmer

00:00.00

» The time counts in hours/minutes/seconds.

« Drag the numbers up or down to change the time.

« Tap the multi-prong icon on the top left-hand side to expand the timer
to fill the screen.

« A bell will ring by default when the time is complete.

IG3 Education Training Manual: EduTouch PX Panel 2.0 21
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ScreenShot |+ Takes a screenshot of a section of the screen or the entire screen.
* Screenshots are saved as a JPG on the panel in the folder:
Screenshots .

Note: If a USB is inserted into the panel, the screenshot is saved
automatically onto the USB.

Magnifier The magnifier enlarges objects.

* Defaults to a circle and can be changed to a square.

« Click the light bulb to remove the background.

» Click the light bulb again to display the original screen.

« Place two fingers or pens in the magnifier and separate them to
resize it.

« Place one finger in the magnifier to move the beam.

Source Switch between the connected devices such as laptops or desktops and
the built-in PC (if purchased). Adjust the panel’s sound and volume.

=] = = =
VGA PC DP HOMIL HDMIZ
= =
USBCl UsSBC
© GEE
» G .

For additional information on connecting devices, refer to page 25.

Voter Voter is an interactive solution for questioning students.

The teacher sets the number of options, the question type and whether

the answers are anonymous. The question is asked verbally, and
students answer on their device after scanning a QR code.

IG3 Education Training Manual: EduTouch PX Panel 2.0 22

PH: (08) 9228 1681 E: INFO@3MONKEYSAV.COM W: WWW.3MONKEYSAV.COM.AU




O & Oy

MONKEYS
=) audiovisual

Professional Boardroom Solutions

Statistics of the results are displayed upon the panel and can be
imported into the Whiteboard.

eeo : i

Blue Ray Tap to turn on the Blue Light Filter.

Lock Tapping the Lock Tool locks the touch and the keypad on the panel.
To disable the lock, tap the panel to display a dialog box allowing you to
enter the password from the pop-up keyboard.

The default password is 0000 and can be changed in Settings.
Note: It is important to remember the password. If it is forgotten,
contact IG3’s Technical Support on 1800 334 633.
Random generates Random numbers.
Random
X

-
Choose the number of groups, the number of random numbers to
generate, and the minimum and maximum numbers.

Record Records the movement on the Panel.

ScreenOff ScreenOff turns the screen off.

» The power light on the front of the panel flashes red and blue.
* Toturn the screen back on, tap the panel with two fingers.

IG3 Education
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Curtain Curtain displays a curtain which hides the contents of the screen.

» Dragthe tag on a side of the screen towards the centre to display
. the contents of the screen.

The curtain’s colour can be changed by tapping the picture icon in
the centre of the panel and selecting a colour.

Tap the x in the centre of the screen to close it.

EduTouch

Spotlight Spotlight blanks the screen except for the projected beam of light.

 Tap the image icon in the bottom centre to change the colour of the

background.

- Place two fingers or pens in the projected beam and separate them to
resize it.

« Place one finger in the beam to move the beam.

« Tap the x in the lower middle of the screen to close it.

The Panel’s Volume and the Brightness can also be adjusted on the Tools menu. If the A

to the right of the brightness is selected, the panel will automatically adjust the
brightness.

ame -
CEE— ®
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Connecting Devices with Cables

Laptops or desktop computers can be connected to the panel using the supplied cables:

« HDMI
 USB-AtoUSB-B

HDMI Connection
If connecting with the HDMI cable, the USB-A to USB-B cable is also needed to enable

the panel’s touch feature. The cable ports are located on the lower right-hand side of
panel and are clearly labeled.
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Using Finger or Panel’s Pen

The Interactive Panel is a 32 point-touch screen.

Both the finger and the pens can be used to access applications, write text, draw, and
select objects.

When using the pen, keep it at a right angle to the screen.

Cleaning the Panel

Maintaining and cleaning your panel can avoid many early faults and keeps the panel
looking like new. Overtime, the interactive panel will accumulate finger marks from

regular use.

Cleaning the Screen

It is important to implement regular cleaning routines:
1. Use a microfiber cloth.
2. Dampen the cloth with warm water.
3. Twist the cloth to completely remove all moisture before wiping the screen.
4. Ensure all parts of the frame are covered.
5. Use a dry microfiber cloth to dry the screen.

Do NOT use ANY chemicals to clean the panel as this will eventually wear down or ruin
the anti-glare coating.

Cleaning the Frame

Regularly dust the panel with a dry microfiber cloth to keep it dust free.
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Appendix A — EShare

EShare is a wireless display solution preloaded on interactive panels. It provides
wireless display and touch control for Windows and Mac laptops and desktops, and
wireless display for iPads, tablets, and mobile phones.

Up to nine devices can be displayed simultaneously and up to 50 devices can be
connected.

EShare requires network access, and all devices must be connected to the same subnet
or able to access the Panel’s Hotspot (refer to page 20 for information).

There are three main features available with EShare:

1. Screen Sharing - Up to nine devices (PC/Mac/Mobiles/Tablets) mirrored on an
interactive panel at one time.

2. TV Mirror to view the panel’s contents on a device.

3. Remote to control the panel from a mobile device.

To begin wireless sharing, EShare must be installed onto either:
* a laptop/desktop (refer to page 32 for information), or
* a mobile device (refer to page 38 for information).

Accessing EShare on the Panel

To access EShare:
1. From the Home Screen, swipe to the left to display the EShare Wireless Projection

main screen.

T e TEn
EduTouch Wi jecti

IG3 Education Training Manual: EduTouch PX Panel 2.0 27

PH: (08) 9228 1681 E: INFO@3MONKEYSAV.COM W: WWW.3MONKEYSAV.COM.AU




MONKEYS
audiovisual

Professional Boardroom Solutions

Updating EShare’s Settings

EShare’s settings can be changed to suit the organisation’s requirements.

To update EShare’s settings:

1. Tap the PIN Code Floating Window.

EduTouch

2.The Settings dialog box opens.

Settings
Device Name: EShare-1339 [#

Connection Mode: [ PIN Code (6 digits)  ~)

PIM Code: 606711 I

PIN Code Refreshing Interval: | 1day -

PIN Code Floating Window: @
Multiple Screens: | 4 Screens =
Show Device Mame on Screen: 1B
Auto Fullscreen: 1B

AirPlay Visible: i)

Chromecast: 1
Check for Update

Close

r-9.9.2 pro Actvated (00:15:86.00.41:41) ZWISEUY

The following settings can be updated:

Field Name

Description

Device Name

EShare’s device name for the panel. This
name can be changed.

Connection Mode

IG3 Education
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Pin Code Displays the current PIN Code.

N

The PTIN Code Refrachi
rrre 1 Iirvyoouagace T TYyoeireormrma

PIN Code Refreshing Interval §
the PIN Code refreshes. The options are

Disable, 10 minutes, 30 minutes, 1 houror 1
day.
Slide to On to display the Pin Code on the

PIN Code Floating Window screen. If set to Off, EShare must be manually
opened to display the code.

Select how many screens can share

simultaneously. The options are Disable, 2
Screens, 4 Screens, 6 Screens or 9 Screens.

Multiple Screens

_ Displays the device name on the screen.
Show device hame on screen

Opens the Share Screen as a full screen.

Auto Fullscreen
Slide to On to allow a device to directly connect

to the panel using Apple AirPlay.
Note: Touch is not supported with AirPlay

AirPlay Visible

devices.
Slide to On to allow a device to directly connect

tothe panetusing Chromecast:

Note: Touch is not supported with
Chromecast devices.

Tap to check if updates are available.

Chromecast

Check for update

Note: EShare’s Settings can also be accessed by tapping Settings on EShare’s
Home Screen and selecting the Settings cog.

EduTouch
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Moderator Control Center

The Moderator Control Center controls the connected device access permissions and
displays the connected devices.

To display the Moderator Control Center:

« From the EShare Wireless Projection Home screen, tap Settings.
* Tap the personicon.

Or,

« Tap the Floating Moderator Button on the right-hand side of the screen.

EduTouch

* The Moderator Control Center opens.

Moderator Control Center X

Share Screen or File:
View, Control and Wireless Annotation:
Floating Moderator Button: [ Auto ‘l
[=] angi B L &

E Angi Mobile & Q) &
Connected device: 2

IG3 Education Training Manual: EduTouch PX Panel 2.0 30

PH: (08) 9228 1681 E: INFO@3MONKEYSAV.COM W: WWW.3MONKEYSAV.COM.AU




MONKEYS
audiovisual

Professional Boardroom Solutions

Field Name Description

Share Screen or File When enabled, any device wishing to access
the panel must be either accepted or rejected
by the presenter.

Available options are: All allowed, Need
authorization, Disable
When enabled, any device wishing to view the

_ panel’s contents on their device must be either
Annotation accepted or rejected by the presenter.

View, Control and Wireless

Available options are: All allowed, View only,
Need authorization, Disable
Displays the Floating Moderator Button options:

Floating Moderator Button Always display, Only on the Home screen,
Disable, Auto

Displaying Connected Devices

A list of connected devices is located on the Moderator Control Center. The presenter
can see whether a connected device is screen sharing onto the panel or TV Mirroring
from the panel onto the device.

Up to nine devices can be displayed simultaneously and up to 50 devices can be
connected.
To display the connected devices:

1. Open the Moderator Control Center (refer to page 30 for information).

Moderator Control Center X

Share Screen or File: | All allowed =
View, Control and Wireless Annotation: | All allowed -
Floating Modarator Bution:

[=] Angi

L &

(el
B L #

E Angi Mobile

Connected device: 2

2. All connected devices are displayed.
3. The presenter can select which devices to Share Screen, TV Mirror or disconnect.

IG3 Education Training Manual: EduTouch PX Panel 2.0 31

PH: (08) 9228 1681 E: INFO@3MONKEYSAV.COM W: WWW.3MONKEYSAV.COM.AU




e

MDNKEYS
audiovisual

Professional Boardroom Solutions

Using EShare with a Laptop / Desktop

Laptop and Desktop devices use the EShare client to connect wirelessly with the panel.
There are three available functions:

1. Share Screen
2. Extend Screen Mode
3. TV Mirror

Installing EShare Client on a Laptop or Desktop

EShare requires network access and must be installed on all devices using it to connect
to the panel.

To install EShare on a Windows or Mac laptop/desktop device:

1. From the panel’s Home Screen, swipe to the right to display the EShare Wireless
Projection Home Screen.

EduTouch

2. To install EShare on a Windows or Mac laptop/desktop, enter www.eshare.app
into a browser.

3. From the EShare Download screen, select the appropriate option.

4. EShare installs and places an icon on the device’s desktop.

Note: EShare is also available on the USB provided with the panel.

IG3 Education Training Manual: EduTouch PX Panel 2.0 32

PH: (08) 9228 1681 E: INFO@3MONKEYSAV.COM W: WWW.3MONKEYSAV.COM.AU



http://www.eshare.app/
http://www.eshare.app/
http://www.eshare.app/

e

MONKEYS
audiovisual

ofessional Boardroom Solutions

Connecting the Panel and a Laptop/Desktop Deviée
To connect:

1.Open EShare from the device’s desktop.
2. Click Connect.

EShare —

Device List

EShare-1339

Please enter the password for
EShare-1339

b “

@ MNetwork: <Ethemet>

3. Enter the connection code displayed on the panel.
4. Click OK.

Connectad to: EShare-1339 B @

shortcut Dstonnet

Ready to share

Share Screen TV Mirror

@ DO (o))

5. The panel and the laptop/desktop are connected.

6. Select either Share Screen (to share the contents of the device onto the panel) or
TV Mirror (to display the contents of the panel onto the device).

**Note: The Floating window can be moved across the top of the panel.
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Share Screen

Share Screen projects the contents of a laptop or desktop onto the panel. Applications,
documents, pictures, videos, and audio can be projected. Laptop and desktop devices
use touch on the panel to control what is being projected.

To share a laptop or desktop’s screen on the panel:

1. Connect the panel and the laptop/desktop device (refer to page 33 for
information).
2. 0n the laptop or desktop, select Share Screen.

Connected to; EShare-1339

Ready to share

Share Screen TV Mirror

8 O (o)

3. On the panel, if Need authorization has been turned on in the Screen Share or
File drop-down list in the Moderator Control Center, a pop-up message displays
on the panel requesting that the presenter either Deny or Allow the share.

4. The laptop or desktop’s screen contents are mirrored onto the panel.

To stop screen sharing:
1. On the laptop or desktop device, access EShare.

2. Click the Stop Sharing icon
3. Close EShare by clicking on the X in the top right-hand corner.

IG3 Education Training Manual: EduTouch PX Panel 2.0
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Extend Screen Mode

Extended Screen Mode projects a file or an application onto the panel and a different
application or file on the laptop or desktop device.

To run extended screen mode:

1. Connect the panel and the laptop/desktop device (refer to page 33 for more
information.)

2. In the Share Screen drop-down list, select Share extend screen.

EShare

Connected ta: EShare-1339 E g:,

Shoftout Dsoonnect

Y

Ready to share

Share Screen TV Mirror

@ O h

3. 0On the panel, if Need authorization has been turned on in the Screen Share or
File drop-down list in the Moderator Control Center, a pop-up message displays
on the panel requesting that the presenter either Deny or Allow the share.

4. On the laptop/desktop, open the file to be displayed on the panel.
5. Slide the file to the right and onto the panel.

To stop extended screen mode:

1. On the laptop or desktop device, access EShare.
2. Click the Stop Sharing icon
3. Close EShare by clicking on the X in the top right-hand corner.

Note: The Extend Screen Mode is only available on laptops and desktops.
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TV Mirror

TV Mirror projects the contents of the panel’s screen onto a laptop or desktop device.
To project the panel’s screen:

1. Connect the panel and the laptop/desktop device (refer to page 33 for more
information).
2. 0On the device, select TV Mirror.

EShare - X

Connected to; EShare-1339 B ‘ 00 .

Ready to share

Share Screen TV Mirror

8 O I

3. On the panel, if Need authorization has been turned oninthe  View, Control and
Wireless Annotation drop-down list in the Moderator Control Center, a pop-up
message displays on the panel requesting that the presenter either Deny or Allow
the view via TV Mirror.

4. The contents of the panel’s screen are projected onto the device.

To annotate on the panel:
1. On the TV Mirror Side Bar, select the Pen icon to activate the Annotation Tool.

EduTouch
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To stop TV Mirror and disconnect the Panel and the device:
1. On the laptop or desktop device, access EShare.
2. Tap Disconnect in the top right-hand corner of the EShare dialog box.

Connectad to: EShare-1339 E
Shortout Dsonne

Ready to share

Share Screen TV Mirror

3. Close EShare by clicking on the X in the top right-hand corner.
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Using EShare with a Mobile Device

EShare connects mobile phones, iPads, and tablets to the panel.
There are seven available functions:

1. Share Screen (Device Mirroring) 2.
TV Mirror 3. Photo 4. Audio/Video 5.
Doc 6. Camera 7. Remote

Note: The screenshots were captured on an Android and an iPhone mobile phone.
Screen displays and some action steps may vary slightly.

Installing EShare Client on a Mobile Device

EShare requires network access and must be installed on all devices using it to connect
to the panel.
To install EShare on a Mobile device:

1. From the panel’s Home Screen, swipe to the right to display the EShare Wireless
Projection Home Screen.

EduTouch Wireless Projection

2. 0n a mobile device, scan the QR code or download EShare from the App Store.
3. The EShare Download screen is displayed. Select the appropriate option.
4. The EShare app is automatically installed onto the mobile device.
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Connecting the Panel and a Mobile Device
EShare requires network access, and all devices must be connected to the same subnet

or able to access the Panel’s Hotspot (refer to page 20 for information).

To connect:

1. Open EShare on the mobile device.
2. 0n the EShare sign-in screen, enter the connection code displayed on the panel

M e @@ + B R TS 103 ol F D
i Device List i Device List
147959 > ] L > ¢}
EShare-1339 EShare-1339

M -

L J L J

Scan
n @] <
Android Apple

3. The panel and the mobile device are connected.
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Share Screen

Share Screen mirrors the display of a mobile device onto the panel.
To share a device’s screen:

1. When the panel and the mobile device are connected (refer to page 38 for more
information), select Share Screen to start sharing the device’s display onto the

panel.

428 ® # 0 - oW, 58%a 11:03 all = -
B EShare & EShare

Connected to; EShare-1339 # Conmectad to  EShare-1339 P

I
| |. Share Screen N7
o8 e [ ! . Share Screen

Or uae AirPlay Mirroring >

‘ .TV Mirror

e
i TV Mirror

M B @ @ 9

Photo  Audio/ Doc Camera Remote | =B i (O] "Q
Video
Android Apple

2. 0n the panel, if Need authorization has been turned on in the Screen Share or
File drop-down list in the Moderator Control Center, a pop-up message displays
on the panel requesting that the presenter either Deny or Allow the share.

3. A pop-up dialog box displays confirming EShare will have access to the
information that is displayed on the device.

=

Start recording or
casting with EShare?
EShare will have access to all of the
information that is visible on your
screen or played from your device

while recording or casting. This
includes information such as
passwords, payment details,
photos, messages and audio that

Screen Broadcast

ml Screen Recording

you play.
Start Broadcast
Cancel Start now
Android Apple
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4. Tap Start Now on the Android device and Start Broadcast on the Apple device.
5. The contents of the mobile device are mirrored onto the panel.

To stop screen sharing:
1. On the mobile device, return to EShare’s main interface.
2. Tap Stop Sharing.

43BeME - o 56%e E wil ¥ W)
@ EShare [ i Share Sereen &
Connected to: EShare-1339 & Connected tg ; EShare-1339 »
@
@

[ Stop Sharing

1l @ <
Android Apple

3. On the Apple device, tap Stop Broadcasting.
4. EShare’s mobile device Home Screen displays.
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TV Mirror

TV Mirror projects the contents of the panel’s display onto a mobile device.
To project the panel’s screen:

1. On the mobile device, tap TV Mirror on the EShare’s main interface.

420 @ - R w, 5B%E 11:03 all = .
EShare I EShare

EShare-1339 ®

Connected to: EShare-1339 ®»

Connected to :

. Share Screen '

|(

|

| | . Share Screen
| J

i uzo ArPlay Mirroring >

[ : TV Mirror ] _
- [ | | TV Mirror ]

m B @ @ S

Photo Audio/ Doc Camera Remote 4] 3 = (o] KN
Video
I @) 4
Android Apple

2. 0n the panel, if Need authorization has been turned on inthe  View, Control and
Wireless Annotation drop-down list in the Moderator Control Center, a pop-up
message displays on the panel requesting that the presenter either Deny or Allow
the view via TV Mirror.

EduTouch

3. The panel’s display is mirrored onto the mobile device.
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4. The EShare TV Mirror Toolbar displays on the right-hand side of the screen:

Feature Description

Displays the Panel’s Home Screen.

Returns BACK to the previous screen.

Accesses photos, audio, video and documents on the phone
and apps on the panel.

Enables Touch.

Annotate.

Removes Annotations.

Opens the Camera. The photo is stored on the phone’s
camera gallery.

EENEEEE

|
1 1
i i

Saves the panel’s display as photo on the phone’s camera
gallery.

r
i

To stop TV Mirror:

1. Tap the Xicon on the upper left-hand corner of the mobile device to return to
EShare’s main interface.
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Photo

The Photo icon projects a photo from the mobile device’s photo gallery onto the panel.
To project a photo:

1. On the mobile device, tap Photo on the EShare’s main interface.

4B B FE - L R ) 11:03 ailll T -
e
Tt EShare & EShare

EShare-1339 »

Connected to: EShare-1339 P

Connected to :

| . Share Screen :
) o e g . Share Screen

O use AlrPlay Mirmoring =

‘—T _TV Mirror )
| . ’ﬁ ) TV Mirror

|2 @ @ 93

Photo | Audiof Doc Camera Remote | M O] ] fﬁ
Video

11 O <

Android Apple

2. The device’s photo gallery is displayed.

3. Select the photo to project.

4. On the panel, if Need authorization has been turned on in the Screen Share or
File drop-down list in the Moderator Control Center, a pop-up message displays
on the panel requesting that the presenter either Deny or Allow the share.

To stop projecting the photo onto the panel:

1. Tap the back arrow in the top-left hand side of the mobile device to return to the
device’s photo gallery.

2. Tap it again to return to EShare’s main interface.
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The Audio/Video icon plays a video or audio file stored on the mobile device onto the
panel.

To play a media file:

1. On the mobile device, tap Audio/Video on the EShare’s main interface.

2. 0n the panel, if Need authorization has been turned on in the Screen Share or
File drop-down list in the Moderator Control Center, a pop-up message displays
on the panel requesting that the presenter either Deny or Allow the share.

A28 ® . oW T. 58%a 11:03 il T .
€ EShare & EShare

EShare-1339 »

Connected to: EShare-1338 P

Connected to :

| |. Share Screen ;
) . Share Screen

O use AirPlay Mirmoring =

‘ TV Mirror )
. ‘ - ‘ TV Mirror

M| 2| @& @ S

Photo | Audio/ | Doc Camera Remote m ] = ”Q
Video
I @) <
Android Apple

2. Select the Video or Audio tab displayed on the top of the screen.
3. Select the media file to play on the panel.

To stop projecting the Audio/Video onto the panel:
1. Tap the back arrow to return to the media files.
2. Tap the back arrow in the top left-hand side to return to EShare’s main interface.
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Doc
DOC, DOCX, PPT, PPTX, XLS, XLSX and PDF documents can be displayed from the

mobile device onto the panel.

To display a document:
1. On the mobile device, tap Doc on EShare’s main interface.

A28 @ 4w WA 58kE 11:03 s -
Frat]
@ EShare & EShare
. EShare-1339
Connected to: i Connectad to  EShare-1338 »

| |. Share Screen "
S o [ . Share Screen

O use AirPlay Mirroring =

TV Mirror

H ‘ TV Mirror
M B el S
Photo .T;.il:‘i?oo," Doc JCamera Remote (2] =3 i o] ﬁq
1] B <
Android Apple

2. The documents list displays.

3. Tap the document to display.

4. On the panel, if Need authorization has been turned on in the Screen Share or
File drop-down list in the Moderator Control Center, a pop-up message displays
on the panel requesting that the presenter either Deny or Allow the share.

5. The document is displayed on the panel in WPS Office.

6. The Remote function is enabled on the mobile device to manage the document.

(Refer to page 48 for more information.)

To stop projecting a doc onto the panel:
1. On the device, tap the Home icon to return to the panel’s Home Screen.
2. Tap the back arrow in the top left-hand side to return to the Document list.
3. Tap the back arrow in the top left-hand side to return to EShare’s main interface.
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Camera

Selecting the camera icon allows the mobile device ‘s camera to take a photo and project
it directly onto the panel.
To take a photo:

1. On the mobile device, tap Camera on EShare’s main interface.

428 ® #H - o 58%E 11:03 all -
bre)
& EShare & EShare

EShare-1339 p

Connected to: _EShare-1338 »

Connected to :

| . Share Screen *
wil 2B . Share Screen

O use AlrPlay Mirroring >

TV Mirror
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2. The device’s camera is activated.

3. On the panel, if Need authorization has been turned on in the Screen Share or
File drop-down list in the Moderator Control Center, a pop-up message displays
on the panel requesting that the presenter either Deny or Allow the share.

4. Tap the white button in the bottom centre of the device to take a photo. The photo
is displayed on the panel.

5. Tap the camera icon to continue taking photos.

6. On the top right-hand side, tap the red cross on the Android device and the red
arrow on the Apple device to return to EShare’s main interface.

Note: The photos are saved in a folder eshare_image on an Android device and in
the Pictures gallery on the Apple device.
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Remote

Remote allows the mobile device to act like a wireless mouse and control the panel.
To activate the remote:

1. On the mobile device, tap Remote on EShare’s main interface.
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2. 0n the panel, if Need authorization has been turned on in the Screen Share or

File drop-down list in the Moderator Control Center, a pop-up message displays
on the panel requesting that the presenter either Deny or Allow the share.

3. The Remote function opens on the mobile device.
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4. The mobile device displays eight options on the bottom of the screen:
» Mouse - the device’s display is used as a mousepad.
* Touch —The device’s display is used to run touch on the panel.
» Keys — can customise 2 shortcut keys to quickly access an App.
* Apps —opens a screen displaying all Apps. Double tap an App to run.
« Home - return to Panel’s Home Screen.
* Back — goes back to the previous screen.
» Keyboard — displays a keyboard.
« Air Mouse — uses the device like a pointer.

5. Tap the back arrow in the top left-hand side of the mobile device to return to
EShare’s main interface.
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Disconnecting the Panel and a Mobile Device
To disconnect the mobile device from the panel:

1. On the mobile device, tap the Disconnect icon in the top right-hand corner of

EShare’s main interface.
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3. Close EShare on the device
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Screen Sharing using Apple AirPlay

To mirror the device using AirPlay:

1. From the Apple Control Centre , tap the Screen Mirroring icon.

2. The Screen Mirroring pop-up displays a list of available screen mirroring devices.

im

Screen Mirroring

@) EShare-1339

3. Tapan “Available Device” to select it and display a tick.
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4. Enter the AirPlay Code.

5. Tap OK.

6. Click away to display the Control Center.
7. Click away to project the device’s display onto the panel.

To stop mirroring using AirPlay:

1. On the Apple device, open the Control Centre and tap the Screen Mirroring
icon. The Screen Mirroring pop-up displays a list of available screen mirroring
devices.

T

Screen Mirroring

EShare-1339

Stop Mirroring

2. Tap Stop Mirroring .
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Appendix B — Media Center

The Media Center is located by opening the APPS screen and selecting Media Center.

What is DLNA?

DLNA stands for “Digital Living Network Alliance”, and it’s simply a set of guidelines that
make it easy to set up a device, like an EduTouch Panel to stream videos, photos, and
music from DLNA devices on the network.

The DLNA server can be run on Windows, Macs, iPhones, and Android devices. A third-

Party DLNA media server is not required with Windows to send media to an interactive
panel, whereas with the other devices an app must be downloaded to send media.

Enabling a DLNA server on Windows 10, 11 and
previous versions

To turn on media streaming:

1. Open Start.

2. Search for Media Streaming Options.

3. Click the result to open the Control Panel on that section.
4. Click Turn on media streaming to enable DLNA.

4 I o Metwork and Sharing Center » Meda streaming cptions w @ | Search Cortrol Panel -

Choose media streaming options for computers and devices

| e s o e on
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H yeru tumm o rrredha SLEBMINgG, yous Curtent network profile and finewell settings will be modified.
ou shoubd furm on media streaming only om netwerics that you tst, sch 25 home or work
netwoeks.
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5. Click OK to apply the settings and complete the task.

4 I o Metwork and Sharing Center » Medka streaming options w B Search Comtrol Pamel o

Choose media streaming options for computers and devices
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All devides are sllewed 1o sccess your thaned madu.

6. Enter a meaningful name for your library.
7. A list of the DLNA-enabled devices currently on the local network with access to

your content is displayed. Uncheck the Allowed option to block the device.

Note: The shared media will not be available to another device when your PC is

sleeping. To change this, click the Choose power options link and configure your
PC to stay awake.

Once all steps are completed, your account libraries (Music, Pictures, and Videos)

will automatically be available to any streaming device with access to your
network.

Enabling a DLNA server on a Apple Mac / i10S, or
Android device

One of the available free or paid for DLNA servers will need to be selected and installed
onto your device. Follow the instructions from the supplier to set up the server.
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Accessing the Media Center
The Media Center is located on the APPS screen. If the DLNA server has been enabled

on the network, videos, audio and pictures can be streamed from that device onto the
panel.
To run the media player:

1. On the Home Screen, open the APPS Screen.
2. Select the Media Center.

3.Tap DLNA_DMP todisplay the enabled devices.

4. Select a device.
5. Choose what type of media to stream — Music, Pictures, Playlists or Videos.

6. Select the media file.
7. The media starts streaming on the panel.
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